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Abstract

These Application Notes describe a solution for integrating RAD Data Communication IPmux
Gateway with Avaya Communication Manager using two different media gateways, Avaya
G650 and Avaya G350. RAD IPmux Gateway is connected to Avaya gateways through a T1
interface. RAD IPmux is a TDM over IP gateway that enables the TDM T1/EL1 circuits to be
extended over an IP/Ethernet network.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe a solution for integrating RAD Data Communications IPmux
(IPmux) Gateway with Avaya Communication Manager using two different media gateways,
Avaya G650 and Avaya G350. IPmux Gateway is connected to Avaya gateways through a T1
interface. RAD IPmux is a TDM over IP (TDMolP) gateway that enables the TDM T1/E1
circuits to be extended over an IP/Ethernet network. The device supports 1to 4 T1 or E1 TDM
facilities and converts the data streams coming from its TDM ports into packets that are extended
over the Fast Ethernet or Giga Ethernet network port, and vice versa. RAD IPmux deploys
TDMolP technology (as well as standard CESoPSN, SAToP and HDLCoPSN) to extend voice
and signaling protocols transparently over packet networks. An Avaya C364T-PWR Converged
Stackable Switch and MM314 Power over Ethernet (PoE) HDDM Media Module on Avaya
G350 were interconnected to each end of IPmux gateway to provide the IP packet network.

For additional information on RAD Data Communications, refer to RAD IPmux documentation

[3].

Figure 1 illustrates the network configuration used to verify the RAD Data Communication
solution. A T1 interface was used between IPmux and Avaya gateways.
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Figure 1 Test configuration of RAD IPmux with Avaya G650 and G350 Media Gateways
(T1 Interface)
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2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment Software/Firmware
Avaya S8710 Servers Avaya Communication Manager 5.0
(R015x.00.0.825.4)
Avaya G650 Media Gateway with S8710 Servers | Avaya Communication Manager 5.0
(R015x.00.0.825.4)
TN464GP DS1 Card HWO02 FW 022
TN2312BP IP Server Interface HW12 FW 40
TN799DP C-LAN Interface HWO01 FW 26
Avaya 4600 Series SIP Telephones 2.2.2 (4610SW SIP)

2.3 (4602SW H.323)
2.6 (4610SW H.323)
2.5 (4625SW H.323)

Avaya one-X Desktop Edition 2.1 SP2
Avaya 6400 and 8400 Series Digital Telephones -
Avaya C364T-PWR Converged Stackable 45.14
Switch
Avaya G350 Media Gateway with S8300B | Avaya Communication Manager 4.0
Server (R014x.00.1.731.2)
MM710AP DS1 Card HWO02 FW 018
MM314 PoE HDDM Media Module HWO00 FW 00
RAD Device
| IPmux 24 HW 00.00 FW 01.00

3. Configure Avaya Communication Manager

This section describes the necessary configuration on Avaya Communication Manager for T1
operations with IPmux. Configuration steps for configuring Avaya G650 and Avaya G350 are
almost identical. Differences in configuration will be pointed out. The configuration of Avaya
Communication Manager was performed using the System Access Terminal (SAT).
Configuration in the following sections is only for the fields where a value needs to be entered or
modified. Default values are used for all other fields. After completion of the configuration in
this section, perform a save translations command to make the changes permanent. Refer to [1]
for additional details.
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3.1. Verifying System Parameters

These steps are common for Avaya G650 and Avaya G350 and are to verify that the proper
options are set.

Step Description
1. | Enter the display system-parameters customer-options command and proceed to Page
3 to verify that DS1 MSP field is setto y.
display system-parameters customer-options Page 3 of 10
Abbreviated Dialing Enhanced List? n Audible Message Waiting? n
Access Security Gateway (ASG)? n Authorization Codes? n
Analog Trunk Incoming Call ID? n Backup Cluster Automatic Takeover? n
A/D Grp/Sys List Dialing Start at 01? n CAS Branch? n
Answer Supervision by Call Classifier? n CAS Main? n
ARS? y Change COR by FAC? n
ARS/AAR Partitioning? y Computer Telephony Adjunct Links? n
ARS/AAR Dialing without FAC? y Cvg Of Calls Redirected Off-net? n
ASAl Link Core Capabilities? n DCS (Basic)? n
ASAlI Link Plus Capabilities? n DCS Call Coverage? n
Async. Transfer Mode (ATM) PNC? n DCS with Rerouting? n
Async. Transfer Mode (ATM) Trunking? n
ATM WAN Spare Processor? n Digital Loss Plan Modification? n
ATMS? n DS1 MSP? vy
Attendant Vectoring? n DS1 Echo Cancellation? y
2. | Proceed to Page 5 and verify that Station and Trunk MSP field is setto y.
display system-parameters customer-options Page 5 of 10
OPTIONAL FEATURES
Multinational Locations? n [Station and Trunk MSP? y|
Multiple Level Precedence & Preemption? n Station as Virtual Extension? n
Multiple Locations? n
System Management Data Transfer? n
Personal Station Access (PSA)? n Tenant Partitioning? n
Posted Messages? n Terminal Trans. Init. (TTI)? n
PNC Duplication? n Time of Day Routing? n
Port Network Support? y Uniform Dialing Plan? y
Usage Allocation Enhancements? y
Processor and System MSP? n TN2501 VAL Maximum Capacity? y
Private Networking? y
Processor Ethernet? n Wideband Switching? n
Wireless? y
Remote Office? n
Restrict Call Forward Off Net? y
Secondary Data Module? y
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3.2. Configuring DS1 for ISDN-PRI Trunks

Following steps are for adding a DS1 card for the ISDN-PRI trunks. Step 1 is for configuring
DS1 card on Avaya G650 and Step 2 is for configuring DS1 card on Avaya G350.

Step Description
1. | Enter the add ds1 1a07 command and configure as follows for Avaya G650:
e Name — Set to any descriptive string.
e Line Coding — Set to b8zs.
e Framing Mode — Set to esf.
¢ Signaling Mode — Set to isdn-pri.
e Connect - Set to pbx.
e Interface — Set to network.
add dsl1 1a07 Page 1 of 2
DS1 CIRCUIT PACK
Location: 01A07 Name: T1 IPMUX
Bit Rate: 1.544 Line Coding: b8zs|
Line Compensation: 1 [Framing Mode: esf
[Signaling Mode: isdn-pri
Connect: pbx [Interface: network|
TN-C7 Long Timers? n Country Protocol: 1
Interworking Message: PROGress Protocol Version: a
Interface Companding: mulaw CRC? n
Idle Code: 11111111
DCP/Analog Bearer Capability: 3.1kHz
T303 Timer(sec): 4
Slip Detection? n Near-end CSU Type: other
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Step Description
2. | Enter the add ds1 1v5 command and configure as follows for Avaya G350:
e Name — Set to any descriptive string.
e Line Coding — Set to b8zs.
e Framing Mode — Set to esf.
e Signaling Mode - Set to isdn-pri.
e Connect — Set to pbx
e Interface — Set to user.
add dsl1 1v5 Page 1 of
DS1 CIRCUIT PACK
Location: 001V5 Name: T1 I1PMUX|
Bit Rate: 1.544 Line Coding: b8zs|
Line Compensation: 1 [Framing Mode: esf
[Signaling Mode: isdn-pri|
Connect: pbx [Interface: user|
TN-C7 Long Timers? n Country Protocol: 1
Interworking Message: PROGress Protocol Version: a
Interface Companding: mulaw CRC? n
Idle Code: 11111111
DCP/Analog Bearer Capability: 3.1kHz
T303 Timer(sec): 4
Slip Detection? n Near-end CSU Type: other
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3.3. Configuring ISDN-PRI Trunks

To configure the trunks, a trunk group is added and then a signaling group for that trunk group is
added. The trunk group is then modified to add the members of the trunk group.

Step Description
1. | Enter the add trunk-group <t>, where t is an available trunk group and configure as
follows:
e Group Type — Set to isdn.
e Group Name — Set to any descriptive string.
e TAC - Enter any value per the dial plan. Set to 141 for this compliance testing.
e Service Type — Set to tie.
add trunk-group 41 Page 1 of 21
TRUNK GROUP
Group Number: 41 Group Type: isdn| CDR Reports: y
Group Name: T1 PRI| COR: 1 TNz 1
Direction: two-way Outgoing Display? n Carrier Medium: PRI/BRI
Dial Access? y Busy Threshold: 255 Night Service:
Queue Length: O
[Service Type: tig¢ Auth Code? n TestCall ITC: rest
Far End Test Line No:
TestCall BCC: 4
2. | Enter the add signaling-group <s> command, where s is an available signaling group
and configure as follows:
e Group Type — Set to isdn-pri.
e Primary D-Channel — Set to 01A0724.
e Trunk Group for Channel Selection — Set to 41, the trunk group created in
Step 1.
add signaling-group 41 Page 1of 5
SIGNALING GROUP
Group Number: 41 Group Type: isdn-pri
Associated Signaling? y Max number of NCA TSC: O
Primary D-Channel: 01A0724 Max number of CA TSC: O
Trunk Group for NCA TSC:
[Trunk Group for Channel Selection:41
Supplementary Service Protocol: a
AT; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 23

SPOC 11/24/2008 ©2008 Avaya Inc. All Rights Reserved. ACMIPmMuxT1




Step Description
3. | Enter change trunk-group <t> command, where t is the trunk group created in Step 1
and go to Page 5 of the trunk-group form. Add 15 ports along with signaling group
created in Step 2.
change trunk-group 41 Page 5 of 21
TRUNK GROUP
Administered Members (min/max): 0/0
GROUP MEMBER ASSIGNMENTS Total Administered Members: 0
Port Code Sfx Name Night Sig Grp
1: 01a0701 TN464 G 41
2: 01a0702 TN464 G 41
3: 01a0703 TN464 G 41
4: 01a0704 TN464 G 41
5: 01a0705 TN464 G 41
6: 01a0706 TN464 G 41
7: 01a0707 TN464 G 41
8: 01a0708 TN464 G 41
9: 01a0709 TN464 G 41
10: 01a0710 TN464 G 41
11: 01a0711 TN464 G 41
12: 01a0712 TN464 G 41
13: 01a0713 TN464 G 41
14: 01a0714 TN464 G 41
15: 01a0715 TN464 G 41
4. | Go to Page 6 of the trunk-group form and enter remaining 8 ports. Port 24 is used for
signaling.
change trunk-group 41 Page 6 of 21
TRUNK GROUP
Administered Members (min/max): 0/0
GROUP MEMBER ASSIGNMENTS Total Administered Members: 0
Port Code Sfx Name Night Sig Grp
16: 1a0716 TN464 G 41
17: 1a0717 TN464 G 41
18: 1a0718 TN464 G 41
19: 1a0719 TN464 G 41
20: 1a0720 TN464 G 41
21: 1a0721 TN464 G 41
22: 1a0722 TN464 G 41
23: 1a0723 TN464 G 41
24:
25:
26:
27:
28:
29:
30:
5. | Repeat Steps 1-4 to configure trunks on Avaya G350.
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3.4. Configuring Dial Plan/Routing

To route the calls properly between the two PBXs, a uniform dial plan is created. A route pattern
is defined to handle the calls which match a certain criteria for the Called Party Number.

Step Description
1. | Enter the change uniform-dialplan <u>, where u is the matching pattern and
configure as follows:
e Matching Pattern — Pattern to match for the Called Party Number. Set to 5 for
this compliance test.
e Len - Length of the Called Party Number.
e Net - Setto aar.
change uniform-dialplan 5 Page 1 of 2
UNIFORM DIAL PLAN TABLE
Percent Full: O
Matching Insert Node
Pattern Len Del Digits Net Conv Num
5 5 0 aar n
2. | Enter the change route-pattern <r> command, where r is route pattern and configure
as follows:
e Grp No - Set to 41, trunk group created in Section 3.3, Step 1.
e FRL-SettoO.
change route-pattern 41 Page 1of 3
Pattern Number: 41 Pattern Name:
Grp FRL NPA Pfx Hop Toll No. Inserted DCS/ 1XC
No Mrk Lmt List Del Digits QSIG
Dgts Intw
1: 41 O n user
2: n user
3: n user
4: n user
5: n user
6: n user
BCC VALUE TSC CA-TSC ITC BCIE Service/Feature BAND No. Numbering LAR
01234W Request Dgts Format
Subaddress
1: yyyyynn rest none
2: yyyyyn n rest none
3:yyyyyn n rest none
4: yyyyyn n rest none
5:yyyyyn n rest none
6 yyyyyn n rest none
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Step Description
3. | Enter change aar analysis <a> command, where a is dialed string of the Called Party
Number and configure as follows:
e Dialed String — Partial or completely dialed number string.
e Total Min — Minimum number of digits in the dialed string. Set to 5 for this
compliance testing.
e Total Max — Maximum number of digits in the dialed string. Set to 5 for this
compliance testing.
e Route Pattern — Set to 41, the route pattern created in Step 2.
e Call Type — Set to aar.
change aar analysis 5 Page 1 of 2
AAR DIGIT ANALYSIS TABLE
Percent Full: 6
Dialed Total Route Ccall Node ANI
String Min Max Pattern Type Num Reqd
5 5 5 41 aar n
4. | Repeat Steps 1-3 to configure dialplan and routing in Avaya G350.
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3.5. Configuring T1 QSIG Trunks

The configuration for setting up a T1 QSIG trunk is similar to the T1 ISDN-PRI trunk and the
only changes are on the DS1 form.

Step Description
1. | Enter the change ds1 1a07 and configure as follows on Avaya G650:
e Name — Set to any descriptive string.
e Line Coding — Set to b8zs.
e Framing Mode — Set to esf.
¢ Signaling Mode — Set to isdn-pri.
e Connect - Set to pbx.
e Interface — Set to peer-master.
change dsl 1a07 Page 1 of 2
DS1 CIRCUIT PACK
Location: 01A07 Name: T1 QSIG
Bit Rate: 1.544 Line Coding: b8zs|
Line Compensation: 1 [Framing Mode: esf
[Signaling Mode: isdn-pri|
Connect: pbx [Interface: peer-master]
TN-C7 Long Timers? n Peer Protocol: Q-SIG
Interworking Message: PROGress Side: b
Interface Companding: mulaw CRC? n
Idle Code: 11111111
DCP/Analog Bearer Capability: 3.1kHz
T303 Timer(sec): 4
Slip Detection? n Near-end CSU Type: other
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Step Description
2. | Enter the change ds1 1v5 command and configure as follows for Avaya G350:
e Name — Set to any descriptive string.
e Line Coding — Set to b8zs.
e Framing Mode — Set to esf.
e Signaling Mode - Set to isdn-pri.
e Connect — Set to pbx
e Interface — Set to peer-slave.
change dsl 1v5 Page 1 of 2
DS1 CIRCUIT PACK
Location: 001V5 Name: T1 QSIG
Bit Rate: 1.544 Line Coding: b8zs|
Line Compensation: 1 [Framing Mode: esf
[Signaling Mode: isdn-pri
Connect: pbx [Interface: peer-slavel
TN-C7 Long Timers? n Country Protocol: 1
Interworking Message: PROGress Protocol Version: a
Interface Companding: mulaw CRC? n
Idle Code: 11111111
DCP/Analog Bearer Capability: 3.1kHz
T303 Timer(sec): 4
Slip Detection? n Near-end CSU Type: other
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3.6. Configuring T1 Robbed-Bit Trunks

The following screens show how to configure a DS1 card for T1 robbed-bit. No signaling group
needs to be specified as robbed-bit signaling method uses bits from each of the 24 DS-0
channels. In cases where a previously configured DS1 card is used, then the DS1 card and its
associated trunk and signaling groups should be removed prior to configuring the DS1 card for
T1 robbed-bit.

Step

Description

1.

Enter the add ds1 1a07 command and configure as follows for Avaya G650:
e Name — Set to any descriptive string.

Line Coding — Set to b8zs.
Framing Mode — Set to esf.
Signaling Mode — Set to robbed-bit.

add dsl1 1a07

Location:
Bit Rate:
Line Compensation:

Page 1 of 2

DS1 CIRCUIT PACK

01A09
1.544
1

[Signaling Mode:

robbed-bit

Interface Companding:
Idle Code:

mullaw
11111111

Slip Detection? n

Name: T1 Robbed Bit
[Cine Coding: b8zs
[Framing Mode: esf

Near-end CSU Type: other
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Step

Description

Enter the add trunk-group <t>, where t is an available trunk group and configure as
follows:

e Group Type — Set to tie.

e Group Name — Set to any descriptive string.

e TAC - Enter any value per the dialplan. Set to 141 for this compliance testing.

e Trunk Type — Set to wink/wink.

add trunk-group 41 Page 1 of 20
TRUNK GROUP

Group Number: 41 Group Type: tie€| CDR Reports: y
Group Name: COR: 1 TN: 1
Direction: two-way Outgoing Display? n Trunk Signaling Type:
Dial Access? n Busy Threshold: 255 Night Service:
Queue Length: 0O Incoming Destination:
Comm Type: voice Auth Code? n
Trunk Flash? N

Trunk Type:

Go to Page 5 of the trunk-group form and add 15 ports.

add trunk-group 41 Page 5 of 21
TRUNK GROUP
Administered Members (min/max): 0/0
GROUP MEMBER ASSIGNMENTS Total Administered Members: 0]

Port Code Sfx Name Night Mode Type Ans Delay
- 01A0701 TN464
: 01A0702 TN464
- 01A0703 TN464
: 01A0704 TN464
- 01A0705 TN464
- 01A0706 TN464
: 01A0707 TN464
- 01A0708 TN464
: 01A0709 TN464
- 01A0710 TN464
: 01A0711 TN464
- 01A0712 TN464
: 01A0713 TN464
- 01A0714 TN464
- 01A0715 TN464

OCoO~NOOODWNE

PR PR
NwNRFRO
POOOOIOOOOOO® OO ®

=
(6]
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Step

Description

Go to Page 6 of the trunk-group form and enter remaining 9 ports.

add trunk-group 41 Page 6 of 21
TRUNK GROUP
Administered Members (min/max): 0/0
GROUP MEMBER ASSIGNMENTS Total Administered Members: 0

Port Code Sfx Name Night Mode Type Ans Delay
16: 01A0716 TN464
17: 01A0717 TN464
18: 01A0718 TN464
19: 01A0719 TN464
20: 01A0720 TN464
21: 01A0721 TN464
22: 01A0722 TN464
23: 01A0723 TN464
24: 01A0724 TN464

OOOOOOOOO

Repeat Step 1-4 for Avaya G350.
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3.7. Configuring T1 Common-Channel Trunks

The following screens show how to configure a DS1 card for T1 common-channel. No signaling
group needs to be specified as common-channel signaling method is used. Only configuration for
DS1 card is shown here as the trunks and its members are added the same way as for robbed bit
signaling in Section 3.6 except port 24 is used for signaling. In cases where a previously
configured DS1 card is used, then the DS1 card and its associated trunk and signaling groups
should be removed prior to re-configuring the DS1 card.

Step Description

1. | Enter the add ds1 1a07 command and configure as follows for Avaya G650:
e Line Coding — Set to b8zs.

e Framing Mode — Set to esf.

¢ Signaling Mode — Set to common-chan.

add dsl1 1a07 Page 1 of 2
DS1 CIRCUIT PACK
Location: 01A09 Name: T1-RBS
Bit Rate: 1.544 [Cine Coding: b8zs|
Line Compensation: 1 [Framing Mode: esf|

[Signaling Mode: common-chan

Interface Companding: mulaw
Idle Code: 11111111

DMI-BOS? n
Slip Detection? n Near-end CSU Type: other
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Step Description
2. | Enter the add trunk-group <t>, where t is an available trunk group and configure as
follows:
e Group Type — Set to tie.
e Group Name — Set to any descriptive string.
e TAC - Enter any value per the dial plan. Set to 141 for this compliance testing.
e Trunk Type — Set to wink/wink.
add trunk-group 41 Page 1 of 20
TRUNK GROUP
Group Number: 41 Group Type: tie€| CDR Reports: y
Group Name: T1 Common Channel] COR: 1 TN: 1
Direction: two-way Outgoing Display? n Trunk Signaling Type:
Dial Access? n Busy Threshold: 255 Night Service:
Queue Length: 0O Incoming Destination:
Comm Type: voice Auth Code? n
Trunk Flash? N
Trunk Type:
3. | Repeat Step 1-2 for Avaya G350.
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4. Configuring RAD IPmux Gateway

IPmux can be configured using either a Hyper Terminal or a telnet session. The following
screens show the T1 configuration. IPmux configuration should match the local PBX
configuration.. To configure IPmux device, telnet into the device, using a proper user name and
password. At any given time, and especially after a configuration change, it is recommended to
save the DB changes by pressing the “s” key.

4.1. Configuring T1 ISDN-PRI, QSIG and Common-Channel

Step Description
1. At the Main Menu screen (Not shown), navigate to the Configuration - Systems >
Management->Host IP page and configure the IP address of the device.
1. IP address > (192.45.80.230)|
2. IP Mask > (255.255.255.128)
3. Default Gateway > (192.45.80.1)
4. DHCP > (Disable)
5. Read > (public)
6. Write > (private)
7. Trap > (public)
2. Navigate to the Configuration = Physical layer page. Make sure the TDM Interface
Type is T1.
1. TDM Interface Type > (TD)|
2. TDM
3. Eth
3. Configure the physical layer parameters of the TDM port. Navigate to the Configuration
-> Physical layer->TDM (T1) page.
1. Administrative Status > (up)
2. Transmit Clock Source > (Loopback)
3. Source Clock Quality > (other/unknown)|
4. Rx Sensitivity > (Short haul)
5. Trail Mode > (Extention)
6- Line Type > (ESP)]
7. Line Code > (B82S)
8. Line Interface > (DSU)
9. Line Length (feet) > (0-133)
10. Restoration Time > (Fast (1 Second))
11. 1dle Code > (7E)
12. Send Upon Fail > (00S code)
13. 00S Code > (7F)
14. Signaling Mode > (None)
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Step Description
4. Configure the PW Connection Parameters. Navigate to the Configuration -
Connection page.
PW Type > (TDMolP CE)
PSN Type (UDP/1P)
1. PW Host IP >
2. Bundle 1D[1-127] .
3. DSO Bundle [1>
4. Bundle Connection >
5. Configure the time slots assignments. Navigate to the Configuration = Connection -
DS0 Bundle page.
+1 +2 +3 +4 +5 +6 +7 +8 +9 +10
TS 0 1 1 1 1 1 1 1 1 1 1
TS 10 1 1 1 1 1 1 1 1 1 1
TS20 1 1 1 1 1 1 1 1 1 1
1. Change cell [0 — 1] ...(b)
6. Navigate to the Configuration - Connection->Bundle Connection page to configure
the PW Bundle parameters.
1. Destionation IP Address .-.-(192.45.50.20)|
2. Next Hop .-
3. IP TOS[0 — 255] ..(0)
4. Connection Status (Enable)
5. Destination Bundle[1l — 8063] (D
6. TDM Bytes In Frame(x48 Bytes)[1 — 30] &)
7. Payload Format > (V2)
8. Far End Type > (T1(ESF))
9. OAM Connectivity (Enable)
10.Jitter Buffer [msec][2.5 — 200] ..(3.0)
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4.2. Configuring T1 Robbed-Bit

Step Description
1. Setting up for the T1 robbed-bit will be similar to ISDN-PRI, QSIG or common-channel,
except for the following single difference. Navigate to the Configuration = Physical
layer->TDM (T1) page.
N ())
10. Restoration Time > (Fast (1 Second))
11.1dle Code ... (7B)
12_.Send Upon Fail (O0S code)
13.00S Code -. (TP
114_Signaling Mode (Robbed bit)
15.00S Signaling > (Space)
16 .Mark Signaling Code[0 — f] ... (0000000D)
17 .Space Signaling Code[O0 — f] ... (00000001)
AT; Reviewed: Solution & Interoperability Test Lab Application Notes 20 of 23
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5. Interoperability Compliance Testing

Interoperability compliance testing covered connectivity, error recovery, and feature
functionality. Feature functionality testing verified the ability of IPmux TDM over IP solution to
provide PBX to PBX communication to make, receive, transfer, and conference calls.
Connectivity functionality testing verified that IPmux gateways were able to connect to Avaya
G650 and Avaya G350 gateways over T1 using ISDN-PRI, QSIG, robbed-bit and common-
channel.

5.1. General Test Approach

All test cases were performed manually. For each T1 configuration the direct connection
between the Avaya G650 and Avaya G350 were tested first. Once, calls could be made between
two sites, then, IPmux devices were introduced to verify the operation. The following features
and functionality were verified:
= T1 connectivity with ISDN-PRI
T1 connectivity with QSIG
T1 connectivity with robbed-bit
T1 connectivity with common-channel
Transfers and Conference calls
Modem Calls
FAX with various bandwidths
DTMF

5.2. Test Results

All test cases passed. IPmux provided connectivity between Avaya G650 and G350 Media
Gateways over T1. During the test, no problems were encountered.

6. Verification Steps
To verify that the solution was properly configured in the field, the following steps can be taken.

After IPmux gateways are connected, make sure that the physical connection (Layer 2) is good
by executing test board 1AXX, where 1 is the cabinet ID, A is the carrier ID and XX is the slot
number of the DS1 board.

If the connection is OK, check the trunk status by running “status trunk YY” where YY is the
trunk-group number.

Place calls between Site A and Site B to verify proper connectivity. Fax machines were utilized
in Site A and Site B to verify proper operation (Tested with 4.8Kbps, 9.6Kbps and 14.4Kbps).

/. Support

For technical support on IPmux, call RAD Data Communications Support at (800)444-7234 or
send email to techsup@radusa.com.
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8. Conclusion

These Application Notes describe a solution for integrating RAD Data Communications IPmux
Gateway with Avaya Communication Manager using two different media gateways, Avaya
G650 and Avaya G350. RAD IPmux Gateway is connected to Avaya gateways through a T1
interface. RAD IPmux Gateway is a TDM over IP gateway that enables the TDM T1/E1 circuits
to be extended over an IP/Ethernet network. The systems interoperated successfully, providing a
suitable solution for TDMolP in the PBX-to-PBX environment.

9. References

This section references the Avaya and RAD Data Communications documentation that are
relevant to these Application Notes.

The following Avaya product documentation can be found at http://support.avaya.com.

[1] Administration for Network Connectivity for Avaya Communication Manager, Issue 13,
January 2008, Document Number 555-233-504.

[2] Administrator’s Guide for Avaya Communication Manager, Issue 4, January 2008,
Document Number 03-300509.

The following product documentation is provided by RAD Data Communications. For
additional product and company information, visit http://www.radusa.com.

[3] RAD IPmux-24 Installation and Operation Manual: Version 1
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